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1. Macro  

1.1 Overview 

If you perform a task repeatedly in Microsoft Excel, you can automate the task with a macro. A 

macro is a series of commands and functions that are stored in a Microsoft Visual Basic module and 

can be run whenever you need to perform the task. For example, if you often enter long text strings 

in cells, you can create a macro to format those cells so that the text wraps. 

1.2 Enable Developer Tab in Ribbon 

1. Click the Microsoft Office Button , and then click Excel Options.  

2. Click Popular, and then select the Show Developer tab in the Ribbon check box, and press 

[OK]  to confirm. 

 

3. The Developer tab will be enabled.  
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1.3 Record a Macro 

1.3.1 Record a Macro using Macro Recorder 

When you record a macro, Excel stores information about each step you take as you perform a 

series of commands. You then run the macro to repeat, or play back, the commands. If you make a 

mistake when you record the macro, corrections you make are also recorded. Visual Basic stores 

each macro in a new module attached to a workbook. 

1. Select Developer tab, Code Group, Record Macros  

 

2. Perform the following action in the Record Macro dialog box. 

 

· In the Record Macro dialog box, enter a name in the Macro Name box  

· If you want to run the macro by pressing a keyboard shortcut key, enter a letter in the 

Shortcut key box. The shortcut key will override any equivalent default Excel shortcut 

keys while the workbook that contains the macro is open 

· In the Store macro in box, click the location where you want to store the macro. If you 

want a macro to be available whenever you use Excel, select Personal Macro 

Workbook . 

· If you want to include a description of the macro, type it in the Description box. 

· Click [OK] . If you want the macro to run relative to the position of the active cell, record 

it using relative cell references. On the Stop Recording toolbar, click Relative Reference 

so that it is selected. Excel will continue to record macros with relative references until 

you quit Excel or until you click Relative Reference again, so that it is not selected. 

3. Carry out the actions you want to record.  

4. Select View tab, Code Group, Stop Macro when finish the record.  
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1.3.2 Create a macro using Visual Basic Editor 

1. Select Developer tab, Code Group, Visual Basic  

2. Select the Insert Č Module in the Microsoft  Visual Basic Editor.  

3. Type or copy your code into the code window of the module.  

4. If you want to run the macro from the module window, press [F5].  

5. When you're finished editing, click File Č Close and Return to Microsoft Excel. 

 

1.4 Execute the Macro 

The next time you need to flag a cell, you can run the macro. If you're going to use the macro 

frequently, you can create a toolbar button for it, or assign a keystroke for it, or both. 

1.4.1 Run your Macro Using the Tools Menu 

1. Select View tab, Code Group, Macros to call the Macro dialog box.  

2. Click the name of your macro, and then click Run.  
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1.4.2 Create a Toolbar Button to Runs your Macro 

1. Click the Microsoft Office Button, and then click Excel Options, and in the Quick Access 

Toolbar tab. 

2. Select Macros in the Choose command from 

3. Select the macro you want to assign and press the Add button, and then click [OK] .  

 

1.4.3 Assign a Keystroke to Run your Macro 

1. Click the worksheet, and then select Developer tab, Code Group, Macro.  

2. Select the name of your macro, and then click [Options].  

3. In the Shortcut key box, type the key to use along with [Ctrl]  button to run your macro. 

1.5 Managing your Macros 

After you record a macro, you can view the macro code with the Visual Basic Editor to correct 

errors or change what the macro does. For example, if you wanted the text-wrapping macro to also 

make the text bold, you could record another macro to make a cell bold and then copy the 

instructions from that macro to the text-wrapping macro. 

The Visual Basic Editor is a program designed to make writing and editing macro code easy for 

beginners, and provides plenty of online Help. You don't have to learn how to program or use the 

Visual Basic language to make simple changes to your macros. With the Visual Basic Editor, you 

can edit macros, copy macros from one module to another, copy macros between different 

workbooks, and rename the modules that store the macros, or rename the macros. 
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1.6 Introduction to Visual Basic Editor 

1.6.1 Using the Visual Basic Editor 

The Visual Basic Editor is a powerful tool that lets you extend the power and versatility of macros 

beyond anything that can be done through recording alone.  

1. Start Excel and open a new, blank workbook.  

2. Select Developer tab, Code Group, Visual Basic.  

3. In the Project window, double-click ThisWorkbook .  

4. Enter this code into the code window:  

sub test( ) 

   MsgBox "This is only a test." 

end sub 

5. Save the file and then select File Č Visual Basic Editor and close the workbook.  

 

6. Select Developer tab, Code Group, Macros in the Excel worksheet. Then select the previous 

macro ñtextò we created in the Visual Basic Editor.  

 

7. Press [Run]  to execute the macro and a message box will be displayed..  
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1.7 Macro Security 

In Microsoft Office Excel, you can change the macro security settings to control which macros run 

and under what circumstances when you open a workbook. For example, you might allow macros 

to run based on whether they are digitally signed by a trusted developer. 

1.7.1 Macro Security Settings and their Effects 

The following list summarizes the various macro security settings. Under all settings, if antivirus 

software that works with 2007 Microsoft Office system is installed and the workbook contains 

macros, the workbook is scanned for known viruses before it is opened. 

· Disable all macros without notification. Click this option if you don't trust macros. All 

macros in documents and security alerts about macros are disabled. If there are documents that 

contain unsigned macros that you do trust, you can put those documents into a trusted location. 

Documents in trusted locations are allowed to run without being checked by the Trust Center 

security system. 

· Disable all macros with notification. This is the default setting. Click this option if you want 

macros to be disabled, but you want to get security alerts if there are macros present. This way, 

you can choose when to enable those macros on a case by case basis. 

· Disable all macros except digitally signed macros. This setting is the same as the Disable all 

macros with notification option, except that if the macro is digitally signed by a trusted 

publisher, the macro can run if you have already trusted the publisher. If you have not trusted 

the publisher, you are notified. That way, you can choose to enable those signed macros or trust 

the publisher. All unsigned macros are disabled without notification.  

· Enable all macros (not recommended, potentially dangerous code can run). Click this 

option to allow all macros to run. Using this setting makes your computer vulnerable to 

potentially malicious code and is not recommended. 

· Trust access to the VBA project object model. This setting is for developers and is used to 

deliberately lock out or allow programmatic access to the VBA object model from any 

Automation client. In other words, it provides a security option for code that is written to 

automate an Office program and programmatically manipulate the VBA environment and 

object model. This is a per user and per application setting, and denies access by default. This 

security option makes it more difficult for unauthorized programs to build "self-replicating" 

code that can harm end-user systems. For any Automation client to be able to access the VBA 

object model programmatically, the user running the code must explicitly grant access. To turn 

on access, select the check box. 
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1.7.2 Change Macro Security Settings 

You can change macro security settings in the Trust Center, unless a system administrator in your 

organization has changed the default settings to prevent you from changing the settings. 

1. On the Developer tab, in the Code group, click Macro Security. 

2. In the Macro Settings category, under Macro Settings, click the option that you want. Any 

changes that you make in the Macro Settings category in Excel apply only to Excel and do not 

affect any other Microsoft Office program. 
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2. Working with Excel VBA Control  

2.1 Overview 

The main objects used to help a person interact with the computer are Windows controls. There are 

two main ways you can access these objects when working with Microsoft Excel. If you are 

working in Microsoft Excel, you can add or position some Windows controls on the document. To 

do that, on the Ribbon, click Developer. In the Control section, click Insert. 

 

This would display the list of controls available in Microsoft Excel. The controls appear in two 

sections: Form Controls and ActiveX Controls. If you are working on a spreadsheet in Microsoft 

Excel, you should use only the controls in the ActiveX Controls section. If you are working on a 

form in Microsoft Visual Basic, a Toolbox equipped with various controls will appear. 

2.2 Using Additional Objects 

The Developer tab of the Ribbon in Microsoft Excel provides the most regularly used controls. 

These controls are enough for any normal spreadsheet you are developing. Besides these objects, 

other controls are left out but are still available. To use one or more of these left out controls, in the 

Controls section of the Ribbon, click Insert and click the More Controls button. This would open 

the More Controls dialog box. You can scroll up and down in the window to locate the desired 

control. If you see a control you want to use, click it and click [OK]. 
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2.3 Form Controls 

Form controls are the original controls that are compatible with earlier versions of Excel, starting 

with Excel version 5.0. Form controls are also designed for use on XLM macro sheets. You use 

Form controls when you want to easily reference and interact with cell data without using VBA 

code, and when you want to add controls to chart sheets. For example, after you add a list box 

control to a worksheet and linking it to a cell, you can return a numeric value for the current 

position of the selected item in the control. You can then use that numeric value in conjunction with 

the INDEX function to select different items from the list. 

You can also run macros by using Form controls. You can attach an existing macro to a control, or 

write or record a new macro. When a user of the form clicks the control, the control runs the macro. 

However, these controls cannot be added to UserForms, used to control events, or modified to run 

Web scripts on Web pages. 

Icon Name Example Description 

 Label 

 

Identifies the purpose of a cell or text box, or displays 

descriptive text (such as titles, captions, pictures) or brief 

instructions. 

 Group 

box 

 

Groups related controls into one visual unit in a rectangle with 

an optional label. Typically, option buttons, check boxes, or 

closely related contents are grouped. 

 Button 

 

Runs a macro that performs an action when a user clicks it. A 

button is also referred to as a push button. 

 Check 

Box  

 

Turns on or off a value that indicates an opposite and 

unambiguous choice. You can select more than one check box 

on a worksheet or in a group box. A check box can have one of 

three states: selected (turned on), cleared (turned off), and 

mixed, meaning a combination of on and off states (as in a 

multiple selection). 



   Chapter 7 

 

Advanced Microsoft Excel @ Peter Lo 2016 10 

 Option 

Button 

 

Allows a single choice within a limited set of mutually 

exclusive choices; an option button is usually contained in a 

group box or a frame. An option button can have one of three 

states: selected (turned on), cleared (turned off), and mixed, 

meaning a combination of on and off states (as in a multiple 

selection). An option button is also referred to as a radio 

button. 

 List Box 

 

Displays a list of one or more items of text from which a user 

can choose. Use a list box for displaying large numbers of 

choices that vary in number or content. There are three types 

of list boxes: 

A single-selection list box enables only one choice. In this 

case, a list box resembles a group of option buttons, except 

that a list box can handle a large number of items more 

efficiently. 

A multiple-selection list box enables either one choice or 

contiguous (adjacent) choices. 

An extended-selection list box enables one choice, contiguous 

choices, and noncontiguous (or disjointed) choices. 

 Combo 

Box  

 

Combines a text box with a list box to create a drop-down list 

box. A combo box is more compact than a list box but requires 

the user to click the down arrow to display the list of items. 

Use a combo box to enable a user to either type an entry or 

choose only one item from the list. The control displays the 

current value in the text box, regardless of how that value is 

entered. 

 Scroll Bar  

 

Scrolls through a range of values when you click the scroll 

arrows or drag the scroll box. In addition, you can move 

through a page (a preset interval) of values by clicking the 

area between the scroll box and either of the scroll arrows. 

Typically, a user can also type a text value directly into an 

associated cell or text box.  

 Spin 

Button 

 

Increases or decreases a value, such as a number increment, 

time, or date. To increase the value, click the up arrow; to 

decrease the value, click the down arrow. Typically, a user can 

also type a text value directly into an associated cell or text 

box. 
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2.4 ActiveX controls 

ActiveX controls can be used on worksheet forms, with or without the use of VBA code, and on 

VBA UserForms. In general, use ActiveX controls when you need more flexible design 

requirements than those provided by Form controls. ActiveX controls have extensive properties that 

you can use to customize their appearance, behavior, fonts, and other characteristics. 

You can also control different events that occur when an ActiveX control is interacted with. For 

example, you can perform different actions, depending on which choice a user selects from a list 

box control, or you can query a database to refill a combo box with items when a user clicks a 

button. You can also write macros that respond to events associated with ActiveX controls. When a 

user of the form interacts with the control, your VBA code then runs to process any events that 

occur for that control. 

Your computer also contains many ActiveX controls that were installed by Excel and other 

programs, such as Calendar Control 12.0 and Windows Media Player. 

Icon Name Example Description 

 Check Box 

 

Turns on or off a value that indicates an opposite and 

unambiguous choice. You can select more than one check 

box at a time on a worksheet or in a group box. A check 

box can have one of three states: selected (turned on), 

cleared (turned off), and mixed, meaning a combination of 

on and off states (as in a multiple selection). 

 Text Box 

 

Enables you to, in a rectangular box, view, type, or edit text 

or data that is bound to a cell. A text box can also be a 

static text field that presents read-only information. 

 Command 

Button 

 

Runs a macro that performs an action when a user clicks it. 

A command button is also referred to as a push button. 

 Option 

Button 

 

Allows a single choice within a limited set of mutually 

exclusive choices usually contained in a group box or 

frame. An option button can have one of three states: 

selected (turned on), cleared (turned off), and mixed, 

meaning a combination of on and off states (as in a 

multiple selection). An option button is also referred to as a 

radio button. 
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 List Box 

 

Displays a list of one or more items of text from which a 

user can choose. Use a list box for displaying large 

numbers of choices that vary in number or content. There 

are three types of list boxes: 

· A single-selection list box enables only one choice. In 

this case, a list box resembles a group of option 

buttons, except that a list box can handle a large 

number of items more efficiently. 

· A multiple selection list box enables either one choice 

or contiguous (adjacent) choices. 

· An extended-selection list box enables one choice, 

contiguous choices, and noncontiguous (or disjointed) 

choices. 

 Combo Box 

 

Combines a text box with a list box to create a drop-down 

list box. A combo box is more compact than a list box, but 

requires the user to click the down arrow to display the list 

of items. Use to allow a user to either type an entry or 

choose only one item from the list. The control displays the 

current value in the text box, regardless of how that value 

is entered. 

 Toggle 

button 

 

Indicates a state, such as Yes/No, or a mode, such as 

On/Off. The button alternates between an enabled and 

disabled state when it is clicked. 

 Spin Button 

 

Increases or decreases a value, such as a number 

increment, time, or date. To increase the value, click the up 

arrow; to decrease the value, click the down arrow. 

Typically, a user can also type a text value into an 

associated cell or text box. 

 Scroll Bar 

 

Scrolls through a range of values when you click the scroll 

arrows or drag the scroll box. In addition, you can move 

through a page (a preset interval) of values by clicking the 

area between the scroll box and either of the scroll arrows. 

Typically, a user can also type a text value directly into an 

associated cell or text box. 
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 Label 

 

Identifies the purpose of a cell or text box, displays 

descriptive text (such as titles, captions, pictures), or 

provides brief instructions. 

 Image 

 

Embeds a picture, such as a bitmap, JPEG, or GIF. 

 Frame 

Control 

 

A rectangular object with an optional label that groups 

related controls into one visual unit. Typically, option 

buttons, check boxes, or closely related contents are 

grouped in a frame control. 

Note: The ActiveX frame control is not available in the 

ActiveX Controls section of the Insert command. However, 

you can add the control from the More Controls dialog box 

by selecting Microsoft Forms 2.0 Frame. 

 More 

Controls 

 Displays a list of additional ActiveX controls available on 

your computer that you can add to a custom form, such as 

Calendar Control 12.0 and Windows Media Player. You 

can also register a custom control in this dialog box. 
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3. Programming Variables 

3.1 Variables  

3.1.1 Declare and Assign Variables 

In computer programming, you use a variable to store things in memory, so that you can retrieve 

them later for manipulation. Variables have a name and a data type. In VBA you can declare and set 

up your variable with key word Dim.  

Dim MyNumber As Integer 

This code sets up a variable with the name MyNumber. The type of variable is an integer. The Dim 

keyword goes at the start, and tells the programme to set up a variable of this name and type. 

However, there's nothing stored inside of the MyNumber variable. VBA has just allocated the 

memory at this point. To store something inside of a variable, you use the equal sign (=), also 

known as the assignment operator. To store a value of 10, say, inside of the variable called 

MyNumber, you do it like this: 

MyNumber = 10 

The above line reads, "Assign a value of 10 to the variable called MyNumber". So the name of your 

variable comes first, then the equal sign. After the equal sign you type the value that you want to 

store inside of your variable. 

3.1.2 Common Data Type 

Data Type Bytes Used Range of Values 

Boolean 2 True or False 

Integer 2 -32,768 to 32767 

Long 4 -2,147,483,648 to 2,147,483,647 

Single 4 -3.402823E38 to 1.401298E45 

Double  8 
-1.79769313486232E308 to -4.94065645841247E-324, 

4.94065645841247E-324 to 1.79769313486232E308 

Currency 8 -922,337,203,685,477.5808 to 922,337,203,685,477.5807 

Date 8 1 January 1000 to 31 December 9999 

String 
 

Varies according to the number of characters (1 per 

character) 

3.1.3 Variable Names 

You can call your variable anything you like with the following guideline:  

¶ Cannot start a variable name with a number 

¶ Cannot have spaces in your variable names, or full stops (periods) 

¶ Cannot use any of the following characters: !, %, ?, #, $ 

¶ Variable name must be less than 255 characters 
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Examples of valid and invalid variable names: 

Valid Name Invalid Name 

My_Car My.Car (. is not acceptable) 

ThisYear 1NewBoy (Cannot start with number) 

Long_Name_Can_beUSE He&HisFather (& is not acceptable) 

Group88 Student ID (Spacing not allowed) 

3.2 Array 

An array is a way to store more than one value under the same name. The only difference between 

declaring a variable to be an array and declaring an ordinary variable is the round brackets after the 

variable name. An array looks like this when it is declared: 

Dim MyArray( 3) As Integer 

The variable name is MyArray. A pair of round brackets follows the variable name. VBA takes this 

to mean that you want to set up an array. The number of values you want to store using your 

variable name is typed between the round brackets. However, one important point to bear in mind is 

that the first position in the array is 0. So the above array can actually hold 3 values, 0 to 2. To place 

a value in an array position you do it like this: 

MyArray(0)  = 10 

MyArray(1)  = 20 

MyArray(2)  = 30 

In the code above, array position 0 has a value of 10, array position 1 has a value of 20, and so on. 

To get back a value from array, it's just like any other variable: put it on the right of an equal sign: 

ArrayValue  = MyArray(1)  

Notice that you still need the round brackets with a position number between them. The line above 

will store whatever value is at position 1 in the array into the variable to the left of the equal sign. 

3.2.1 Example 
Sub VariableDemo ()  

    Dim var1 As String  

    Dim ArrayDemo( 2) As Integer  

         

    var1 = "Hello World"  

    ArrayDemo(0) = 1 0 

    ArrayDemo(1) = 2 0 

         

    Worksheets(1).Range("A1").Value = var1  

    Worksheets(1).Range("B1").Value = ArrayDemo(0)  

    Worksheets(1).Range("B2").Value = ArrayDemo(1)  

End Sub  
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3.3 Option Explicit 

The use of Option Explicit is to help us to track errors in the usage of variable names within a 

program code. Option Explicit forces the programmer to declare all the variables using the Dim 

keyword. When Option Explicit is included in the program code, we have to declare all variables 

with the Dim keyword. Any variable not declared or wrongly typed will cause the program to popup 

the ñVariable not definedò error message. We have to correct the error before the program can 

continue to run. 

3.3.1 Example 

Compile Error will be prompted if variable havenôt decelerate before use under Option Explicit  

Option Explicit  

Sub OptionExplicit Demo()  

    Dim var1 As String  

     

    var2 = var1  

End Sub  
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4. Arithmetic Operation  

4.1 Overview 

When you store numbers inside of variables, one of the things you can do with them is 

mathematical calculations. The arithmetic precedence is as follow:  

 

4.2 Addition 

In programing languages, the addition sign is the plus (+).  

Sub Add_Numbers ( )  

 Dim Number_1 As Integer  

 Dim Number_2 As Integer  

 

 Number_1 = 10  

 Number_2 = 20  

 

 Worksheets(1).Range("A1").Value = "Addition Answer"  

 Worksheets(1).Range("B1").Value = Number_1 + Number_2  

End Sub  

4.3 Subtraction 

In the VBA programming language, the minus sign (-) is used to subtract one value from another. 

Again, you can use actual values, values stored in variables, or a combination of the two.  

Sub Subtract _Numbers ( )  

 Dim Number_1 As Integer  

 Dim Number_2 As In teger  

 

 Number_1 = 10  

 Number_2 = 20  

 

 Worksheets(1).Range("A2 ").Value = " Subtract  Answer"  

 Worksheets(1).Range("B2 ").Value = Number_1 -  Number_2  

End Sub  
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4.4 Multiplication 

In programing languages, the multiplication sign is the asterisk (*). So if you want to multiply 10 by 

5 in VBA you could do it like this: 

Sub Multiply_Numbers ( )  

 Dim Number_1 As Integer  

 Dim Number_2 As Integer  

 

 Number_1 = 10  

 Number_2 = 5  

 

 Worksheets(1).Range("A3").Value = "Multiplication Answer"  

 Worksheets(1).Range("B3").Value = Number_1 * Number_2  

End Sub  

4.5 Division 

The symbol to use when you want to divide numbers is the forward slash (/).  

Sub Divide _Numbers ( )  

 Dim Number_1 As Integer  

 Dim Number_2 As Integer  

 

 Number_1 = 10  

 Number_2 = 5  

 

 Worksheets(1).Range("A4").Value = "Division Answer"  

 Worksheets(1).Range("B4").Value = Number_1 / Number_2  

End Sub  

4.6 Example 
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5. The Selection Structure 

5.1 Overview 

Also called the decision structure, makes a decision and then takes appropriate action based on that 

decision.  

  

5.2 If Statement 

To effectively control the program flow, we shall use the If...Then...Else statement together with the 

conditional operators and logical operators. The general format for the statement is as follows: 

If condition1  Then 

 Statement1  

ElseIf condition2  Then  

 Statement2  

Else  

 Statement3  

End If  

* Any If...Then...Else statement must end with End If. Sometime it is not necessary to use Else. 

5.2.1 Relational Operators 
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5.2.2 Logical Operators 

 

5.2.3 Order of Operation 

The order of operations for evaluating Boolean expressions is: 

1. Arithmetic Operators 

¶ Parenthesis 

¶ Exponentiation 

¶ Division and multiplication 

¶ Addition and subtraction 

2. Relational Operators 

3. Logical Operators 

¶ Not 

¶ And 

¶ Or 

5.2.4 Example 
Sub IfThenElseDemo(  )  

    If Weekday(Now(), 2) = 6 Or Weekday(Now(), 2) =  7 Then  

        MsgBox ("Enjoy your Weekend!")  

    Else  

        MsgBox ("Work hard!")  

    End If  

End Sub  
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5.3 Select Case.........End Select 

Normally it is sufficient to use the conditional statement If....Then....Else for multiple options or 

selections programs. However, if there are too many different cases, the If...Then...Else structure 

could become too bulky and difficult to debug if problems arise. Fortunately, Visual Basic provides 

another way to handle complex multiple choice cases, that is, the Select Case.....End Select decision 

structure. The general format of a Select Case...End Select structure is as follow: 

Select Case variable  

    Case Value1  

        Statement1  

    Case Value2  To Value3  

        Statement2  

    Case Else  

        Statement3  

End Select  

5.3.1 Example 
Sub SelectCaseDemo()      

    Select Case Weekday(Now(), 2)  

        Case 7  

            MsgBox ("Happy Sunday")  

        Case 1 To 2  

            MsgBox ("Enjoy your Excel Class")  

        Case Else  

            MsgBox ("Play Hard Summer")  

    End Select  

End Sub  
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6. The Iteration Structure 

6.1 Overview 

Directs computer to repeat one or more instructions until some condition is met. Also referred to as 

a Loop, Repeating or Iteration 

  

6.2 DoééLoop 

There are four ways you can use the Do Loop as shown below: 
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6.2.1 Pre Test Loops 

A loop is one of the most important structures in programming. Used to repeat a sequence of 

statements a number of times. The Do loop repeats a sequence of statements either as long as or 

until a certain condition is true. 

 

Consider the following example: 

 

We find that the condition is checked 6 times and 5 execution in the loop. 

 

 



   Chapter 7 

 

Advanced Microsoft Excel @ Peter Lo 2016 24 

6.2.1.1 Do While Loop Example 

Five times is executed in the Do While Loop. 

Sub DoWhileLoop( )  

    Dim counter  As Integer  

 

    counter  = 0  

    Do While counter  < 5  

        counter  = counter  + 1  

        Cells( counter , 1).Value = counter  

    Loop  

End Sub 

 

6.2.1.2 Do Until Loop Example 

No execution in Do Until Loop because the condition is match when enter. 

Sub DoUntilLoop( )  

    Dim counter  As Integer  

 

    counter  = 0  

    Do Until counter  < 5  

        counter  = counter  + 1  

        Cells( counter , 1).Value = counter  

    Loop  

End Sub  
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6.2.2 Post Test Loop 

A Do statement precedes the sequence of statements, and a Loop statement follows the sequence of 

statements. The condition, preceded by either the word ñWhileò or the word ñUntilò, follows the 

word ñDoò or the word ñLoopò. Be careful to avoid infinite loops ï loops that never end. VB allows 

for the use of either the While keyword or the Until keyword at the top or the bottom of a loop. 

 
Consider the following example: 

 

We find that the condition is executed 5 times in the loop. 
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6.2.2.1 Do Loop While Example 

Five times is executed in the Do Loop While. 

Sub DoLoopWhile ( )  

    Dim counter  As Integer  

     

    counter  = 0  

    Do 

        Cells( counter , 1).Value = counter  

        counter  = counter  + 1  

    Loop While counter  < 5   

End Sub  

 

6.2.2.2 Do Loop Until Example 

One times is executed in the Do Loop Until. 

Sub DoLoopUntil()  

    Dim counter  As Integer  

     

    counter  = 0  

    Do 

        counter  = counter  + 1  

        Cells( counter , 1).Value = counter  

    Loop Until counter  < 5  

End Sub  

 

 


